
The Pro Tools users’ guide to delivering a Dolby Atmos mix



What is Dolby 
Atmos Music?

This guide is intended to get you up to speed 
with the software tools from Dolby and Avid in 
order to enable you to create your first music 
mix in Dolby Atmos.

Dolby Atmos was originally created as the next generation format for 
cinema sound, designed, based on feedback from film re-recording mixers. 
Following widespread theatrical adoption, this technology has filtered down 
into the Home Cinema environment for both film and TV content spanning 
drama, documentary, and live events. This is consumed over traditional TV 
broadcast, as well as online streaming platforms such as Netflix, Amazon 
Prime Video, and Apple TV+.

Dolby Atmos Music is a revolutionary new ‘object based’ immersive audio 
format for music production. This new format allows artists to push their 
creative boundaries. With Dolby Atmos Music, mixers have the ability to place 
and move sounds in a 3D environment with more precision, allowing for 
even more creative possibilities. Now, producers can create tracks that allow 
listeners to feel like they’re inside their favourite music.
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Why produce music 
in Dolby Atmos?
Today, hundreds of movies, television shows, and video games are already 
produced in Dolby Atmos, and each year more and more loudspeakers 
and home theatre set-ups are equipped to bring immersive audio to the 
everyday listener. Now with the release of the Amazon Echo Studio along 
with TIDAL adding a Dolby Atmos option to their streaming service, demand 
for immersive music is set to increase.

Even prior to the release of the Amazon Echo Studio, music has been a 
huge element of film and TV content, and with more of this content being 
mixed and consumed in Dolby Atmos, the techniques in the mix for the 
reproduction of scores and soundtracks has evolved, producing really 
incredible results. Films such as ‘Bohemian Rhapsody’ and ‘Rocketman’ are 
incredibly engaging and immersive, and this has led to the demand for, and 
production of, music-only content mixed in Dolby Atmos. 

As noted earlier, several major streaming platforms 
are really pushing the format, with over a thousand 
tracks already available through Amazon with their 
Music HD service and Amazon Echo Studio speaker 
and TIDAL. The tools available for this new and 
exciting format allow artists to further explore the 
creative possibilities of a mix.

We hope you enjoy this guide and if you have questions about Dolby Atmos 
Music reach out to us at contact@hhb.co.uk
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Getting Started
The main software for authoring content is called the Dolby Atmos Production Suite 
(DAPS – Mac only – available on the Avid Store, and as a 30-day trial from Dolby 
here), which is a standalone application providing tools to produce immersive Dolby 
Atmos mixes in Pro Tools or Nuendo with plans to support Apple Logic Pro and 
Ableton Live in the future. We’ll focus on Pro Tools Ultimate for this getting started 
guide, however it’s a very similar setup process in Nuendo. Pro Tools Ultimate 
is required due to the stereo limitation of Pro Tools Standard – we recommend 
2019.12 or higher.

Begin by installing and launching both Pro Tools and DAPS. On the DAPS installer, 
make sure the, ‘Dolby Audio Bridge’, is checked – this will require a reboot. You may 
also need to approve the driver in Mac OS System Preferences / Security & Privacy.

To begin we suggest  downloading our HHB Dolby Atmos Getting Started Pro 
Tools Template here.

Don’t open a session just yet

Having installed and launched both Pro Tools and DAPS, we need to get them 
communicating with each other. Dolby Atmos relies upon user generated, ‘object 
metadata’. Think of an audio ‘object’ as a unique, mono (or stereo) track, such as a 
guitar or vocal track. The metadata is predominantly panning information, sent from 
our Pro Tools Surround Panner, much like lanes of automation. An ‘object’ can be 
panned within a 3D space, represented as a cube in the Pan Window.
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We enable this link via the Setup / Peripherals dialog, on the Atmos tab. Checking 
the ‘Enable’ box and selecting your computer in the drop-down list will make this 
connection – we should see a solid green ‘Connection Status’ light.

Getting Started continued:
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Getting Started continued:

Now let’s set-up the Dolby software. In DAPS / Preferences / Driver, we’ll set our 
‘Audio driver’ to ‘Core Audio’, and our ‘Audio input device’ to ‘Dolby Audio Bridge’. 
Our ‘Audio output device’ should be set to a relevant output option in your studio – 
generally your main audio I/O. In this same dialog, we’ll also configure the ‘External 
sync source’ to ‘LTC over audio’ and our ‘LTC input channel’ to 129. We can also set 
our Dolby Atmos Master File, ‘Frame rate’ and ‘Sample rate’ – we’ll use 25 fps and 
48kHz for now.

To finish setting up the DAPS software, we’ll need to configure our monitoring. If 
you’re going to be monitoring on headphones, enable ‘Headphone only mode’, hit 
‘Accept’, and skip the next section on speaker configurations. The headphone render 
can be a stereo fold-down or a binaural render, which generally does a good job of 
emulating a sense of height and space - we’d recommend trying it. This is selected in 
Preferences / Headphone / Stereo/Binaural

Next, we’ll need to set our Pro Tools ‘Playback Engine’ to the ‘Dolby Audio Bridge’ in 
order to route audio directly from Pro Tools to the Dolby software. This is done in 
the Setup / Playback Engine dialog. Dolby also recommend a 1024 Sample Buffer 
for 48kHz (2048 for 96kHz, which also limits you to 64 total channels).
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Getting Started continued:



Speaker 
Configurations
Having accepted our driver preferences, jump to the section of this guide most 
relevant to your monitoring configuration.

Stereo
For stereo, it’s really quick to set up (for those that just want to use Output 1 & 2 for 
Left & Right) - we can use the ‘2.0’ preset of the default ‘Monitoring’ configurations 
provided by DAPS. These are selected in the top left-hand corner of the main DAPS 
window. If you need channels other than 1 & 2, see ‘Routing’ in the 7.1.4 section.
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Speaker Set Up



5.1 
For 5.1, it’s similar to the stereo setup, but select ‘5.1’ in the ‘Monitoring’ menu. The 
default channel order is Left, Right, Centre, LFE, Left Surround, Right Surround (ch1-
6). In order to change this, see ‘Routing’ in the 7.1.4 section.

7.1.4/other
If you have 7.1.4 or another speaker configuration, you need to go into Window / 
Room Setup to configure our ‘Speaker setup’ and channel ‘Routing’.

In ‘Speaker setup’ we can enable or disable speaker channels by clicking on them in 
order to match our room configuration. The ‘Routing’ tab allows us to change our 
output channel for each speaker output from DAPS to match the interface output 
patching to your speakers.
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Speaker Set Up continued:
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Finally, we need to configure our I/O setup and Pro Tools session – for the purpose 
of getting started quickly, let’s use the, “HHB Dolby Atmos Getting Started Template”, 
to start. We recommend backing up your I/O setup before launching the template.

On launching our template, it’ll prompt to save your new session – select 
somewhere relevant, then let it load, but don’t hit play just yet. You’ll likely need to 
go to the ‘I/O Setup’ and select ‘Restore from Session’ with ‘Apply to all tabs’ selected. 
Should there be an error such as, “Unable to read the I/O settings file”, or another 
issue with this, try importing our I/O setup backup from here. This will sort out our 
‘I/O Setup’ so that we can quickly test our audio routing, before moving on to import 
your own audio into our session template & mix it in Dolby Atmos using the new 3D 
panner tools available. The ‘I/O Setup’ ‘Output’ & ‘Bus’ pages should look something 
like this:

I/O Set Up
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Routing & Panning

We’ve already enabled the ‘Object’ view in both the ‘Edit’ & ‘Mixer’ windows in 
this template. This allows us to view, make and change ‘Object’ assignments per 
track (across the 118 objects we’ve configured), as well as toggling a track’s output 
between the ‘Bed’ & ‘Object’ paths.

Bed 
A ‘Bed’ is our ‘channel based’ main output bus of 7.1.2 (LCR, LFE, Side & Rear 
Surrounds, and a pair of Overhead Surround Channels – these have no forward/
backward separation, just a stereo overhead). Think of this as your main mix bus.

Object  
An ‘Object’ has far more accurate panning, as it’s all governed by metadata rather 
than channel-based pan laws. This allows us to pan audio within a virtual 3D space, 
which will be rendered to be accurately represented in the listeners environment. 
Objects are great when you have specific discrete sounds which want defined 
positions. We’d recommend trying to use objects when mixing Dolby Atmos Music, 
because at 48kHz we have about 118 objects available, generally allowing each 
instrument or voice to have an independent panner.



In our template, we’ve included a pink noise signal generator and some pan 
automation to demonstrate the panner in the 7.1.2 bed, followed by panning the 
same noise as an object. It fades in from the very start of the session, and shouldn’t 
be too loud – keep the volume control to hand to adjust for your environment, and 
you should hear it pan through extents of the 3D space.

When we later place some audio on these tracks (Object 11-128) we can immediately 
interact with our audio in Dolby Atmos. The native 3D Panner in Pro Tools gives us 
access to X, Y and Z (height) controls, as well as a ‘Size’ parameter – all of which are 
fully automatable within the Pro Tools timeline.
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It is important to be aware that when mixing in Dolby Atmos, you can only address 
the LFE (Low Frequency Effect) channel when a track is routed to the bed. The LFE 
control is greyed out when routed as an object. To manually route to the LFE in 
addition, you can use an aux send from your mixer to an LFE sub-path of a bed, 
however this isn’t necessary as all objects and speakers for Dolby Atmos playback 
systems are designed to be ‘full range’. It’s worth noting that anything routed to the 
LFE won’t make it into the default stereo or headphone renders, so consider using 
EQ or level to enhance the bass rather than using the LFE.

When using the 3D panner with a mouse, clicking in the grid will give us control over 
X and Y. By holding the Shift key, we now have independent control over the height, 
and using Shift + scroll wheel gives us access to the Size parameter. There are also 
different modes available to speed up the process of panning in 3D. By default, 
we’re in ‘FreeForm’ mode but have a play to familiarise yourself with each of the 
modes, which are:
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Wedge   
Moving front to back goes from no height to full height (middle) & 
back down to no height at the rear

Freeform   
Completely independent control over X, Y, Z & Size

Dome   
Like a hemisphere or dome, low around the edges, high in the middle.

Ceiling   
Full height for the rear ¾ of the cube, diving down towards the front 
in the final ¼

Routing & Panning continued:



Now you’re all set-up, you should be ready to start mixing in Dolby Atmos by simply 
importing some existing audio into this template. File -> Import -> Audio, converting 
to 48kHz if necessary. We can essentially mix as normal within the Pro Tools 
environment, utilising the additional pan options available and not really having to 
touch the DAPS software. I’d recommend starting with some static pan positions, 
adding some layers of instrumentation to build a good starting point for your 
soundscape, possibly experimenting with the binaural headphone render. Once 
you’ve got a basic mix together, move onto the next step of creating a master file. 
We’ll need to set and check a few things.
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Creating your 
first Dolby Atmos 
Master File (DAMF)
DAPS needs to chase the Pro Tools timeline in order to create a finished master. 
This can be done via Linear or MIDI Timecode. LTC is preferable, and Dolby have 
provided a handy LTC Generator plug-in with the v3.4  or higher update to DAPS. 
We used this plug-in in our template by creating a mono ‘aux’ track in Pro Tools, 
adding the ‘Dolby LTC Generator’ plug-in, set it to ‘solo safe’ (Command+click on the 
‘Solo’ button) and routing it to Output Channel 129 (matching the Dolby setting from 
earlier).



Next, move back to DAPS in order to create a DAMF, which is the master file format 
of a Dolby Atmos mix. 

From the ‘File’ menu, select ‘New Master File’ (Command+N). We then choose a 
‘Master file name’ and select where to save the file to. We can safely ignore the 
‘Optional settings’ for ‘FFOA’, which applies to film and TV more.

We need to treat the mastering portion of the process like recording our mix to tape 
/ DAT / CD etc. It’s a real time record pass from Pro Tools to DAPS. The best way to 
set up for this is to select a ‘Record in/out’ point in DAPS. It’s important to have your 
session start somewhere later than 00:00:00:00 as this won’t allow the software 
enough time to lock to the LTC before audio starts playing. Our template is set up so 
that the audio start is at 01:00:00:00, and so let’s set the record in/out to match the 
duration of the track. We can then record arm DAPS and move back to Pro Tools. 
Also, make sure that timecode chase (blue clock circle) is enabled. This is all done at 
the top of the DAPS window.

Creating your first Dolby Atmos Master 
File (DAMF) continued:
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Creating your first Dolby Atmos Master 
File (DAMF) continued:
Now we simply need to play through our mix, but should either use Pre-Roll or move 
our play head to a couple of seconds prior to our ‘Record in’ point, to allow for the 
timecode chase to lock. The Dolby software should change from a blinking red to a 
solid red once the ‘in’ point is reached, and automatically disarm once past the ‘out’ 
point at the end of our mix.

Throughout this process, you may have noticed the loudness metering. That is 
outside of the scope of this ‘Getting Started’ guide, but we go into measuring 
loudness in Dolby Atmos in a separate blog post.



Creating your first Dolby Atmos Master 
File (DAMF) continued:
This mix now exists as a DAMF, which can be delivered to other DAPS users, but not 
easily reviewed without those tools. We do however have the option to export the 
mix. In order to select the channel format we’d like to export, first we must define 
them in the ‘Window / Re-renders’ page (Command+R). By default, we have a 7.1, 
5.1 & 2.0 Stereo, but we may well want to export the binaural mix. To do this, select 
‘BIN’ in the ‘Layout’ drop-down menu, then click ‘Add’. We can rename this re-render 
by selecting ‘Properties’, and this name will persist through our later export function.
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Creating your first Dolby Atmos Master 
File (DAMF) continued:
Once we’ve added this option, select ‘Accept’, then go to ‘File / Export Audio / Re-
renders’ (Command+E). This dialog allows us to select which re-render exports 
we want, and where to export them. There are options for interleaved or multi-
mono BWAVs, and we can also define a time range. The resultant .WAV file can be 
easily played on many systems. There are also export options for other deliverable 
formats such as .mp4 in the File / Export Audio menu should you require them.



As with any mix it’s worth playing it back on a number of systems and for a variety 
of people, particularly when working with binaural content. There aren’t any hard 
or fast rules regarding mixing in Dolby Atmos, but it’s fair to say that just because 
we have all these new options available to us doesn’t mean we have to use them 
all at once! Less can still be more, and our approach is usually about adding layers 
of detail rather than a mass of sounds whizzing around your head. Certain pan 
automation techniques with width, height and movement are more applicable to 
particular genres – try to experiment with the tools available and hopefully it’ll help 
to expand your creative possibilities.

With regard to further learning, Dolby include a really useful guide resource, 
accessible via Help / Dolby Atmos Renderer Guide. It includes lots more 
information for further reading and is also searchable if you have any specific 
queries. They also offer some additional instructional video content available here, 
and check out our blog for more articles on Dolby Atmos Music, Pro Tools, and 
much more.

Creativity & Review
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